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A new approach for routine quantification of microplastics using Nile Red and automated

software (MP-VAT)

Abstract

Microplastics are widespread contaminants in the environment. However, most identification
protocols rely on long and subjective visual counting, which could be improved using staining dyes.
Thus, the objective of this work is to identify the best staining dye protocol and create an objective
and quick automated counting software for microplastics. Tests were conducted to identify the
most appropriate of eight staining dye solutions and of six wavelengths for virgin and weathered
synthetic polymers, textile fibers, natural organic matter and filters. Nile Red produced the best
results (without interfering in infrared spectra) rendering microplastics fluorescent at 254 nm, but
with limited number of fluorescent polymers, and at 470 nm (with orange filter), with fluorescence
of plastics as well as natural organic matter (requiring a digestion step). Next, a script was
developed in Image) for the automatic quantification and characterization in shape (fiber,
fragment, particle) and size of fluorescent microplastics, the Microplastics Visual Analysis Tool
(MP-VAT). MP-VAT was evaluated, producing recovery rates in the range of 89.0 — 111.1% in
spiked filters under 470 nm. Furthermore, this package is accompanied by a script that sets a scale

from a known filter diameter, MP-SCALE, and a script that allows user threshold setting, MP-ACT.

Keywords: staining dyes; Nile Red; textile fibers; infrared spectra; small microplastics; nanoplastics

1. Introduction



43

44

45

46

47

48

49

50

51

52

53

54

55

56

57

58

59

60

61

62

63

64

65

66

Microplastics (plastics <5 mm) originate from intentional production (primary) or the
fragmentation of larger plastics (secondary), leading to widespread environmental contamination
(Ha and Yeo 2018). Monitoring concentrations of microplastics in the environment is essential to
better understand their sources and sinks. However, most microplastic quantification methods
rely on visual identification, highly amenable to operator biases and errors, thus exhibiting a high
degree of misidentification (Prata et al. 2019a). Nonetheless, this remains an important

inexpensive alternative to spectroscopic detection, and in most cases precedes this analysis.

Staining dyes, such as Nile Red (Erni-Cassola et al. 2017; Maes et al. 2017; Mason eta I. 2018; Shim
et al. 2016; Tamminga et al. 2017) or Rose Bengal (Kosuth et al. 2018; Liebezeit and Liebezeit
2014; Maes et al. 20173a; Ziajahromi et al. 2017), have been used to improve visual identification of
microplastics. By conferring color or fluorescence, microplastics can be easily differentiated from
mineral and organic materials in the sample. However, most staining protocols for microplastics
have been developed and used without any clarification regarding the ability to stain various virgin
and weathered polymers, and the lack of affinity for natural organic matter. Furthermore,
fluorescent microplastics can be photographed and automatically quantified by a counting
software, increasing sample throughput and removing the subjective variation inherent to
different operators. To the best of the authors’ knowledge, this has only been attempted using
Galaxy Count (Mason et al. 2017), but results varied depending on the subjective selection of
threshold values. Thus, current staining dye protocols must be improved through a careful
evaluation of their affinity and selectivity for virgin and weathered polymers, as well as through

the use of detection software.

The objective of the present work was to select the most appropriate staining dye and wavelength
to selectively detect microplastics and to develop an automated counting script based on open-

source software that limits subjectivity in the quantification, resulting in a new approach for
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quantification of microplastics in environmental samples. Therefore, virgin and weathered
polymers, as well as textile fibers and natural organic matter, were exposed to eight staining dye
solutions under two wavelengths (254, 365 nm), then selected the best staining dye (Nile Red) to
undergo selection of wavelengths (254 — 625 nm). Finally, these conditions were used to obtain
images to develop and validate the use of an automated counting software (Microplastics Visual

Analysis Tool) in Imagel.

2. Material and methods

Procedures were conducted on synthetic and natural materials in order to explore the
identification of synthetic polymers by staining dyes and the confounding effect of other materials.
Staining dye solutions were chosen due to their previous use in microplastic samples (e.g. Nile
Red) or their affinity to stain lipophilic materials. Procedures took place to select the best of eight
staining dye solutions, followed by identification of the appropriate excitation wavelength for the
best solution. Determination of these conditions finally allowed the development of an automated
counting software (MP-VAT), which was properly evaluated and then used in environmental

samples.

2.1. Staining dye solutions preparation

Staining dye solutions tested were Acridine Orange (Riedel-de Haen, Germany), Basic Blue 24
(Sigma-Aldrich, U.S.A.), Crystal Violet (Merck, Germany), Lactophenol Blue (Labkem, Spain),
Neutral Red (Merck, Germany), Nile Red (Sigma Aldrich, U.S.A.), Safranin-T (Fluka, Germany),

Trypan Blue (Merck, Germany). Staining dye solutions of 0.01 mg ml™ (Maes et al. 2017a) were
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prepared in reagent grade ethanol (Fisher Scientific, U.K.) in amber glass bottles, except for Trypan
Blue which was dissolved in ultrapure water (owning to its low solubility in ethanol) and

Lactophenol Blue which was acquired as a solution and was diluted 50 times in ethanol.

2.2. Sample collection for staining experiments

Virgin polymers were obtained from Sigma-Aldrich (U.S.A.), namely low-density polyethylene
(LDPE), polypropylene (PP) and polystyrene (PS), or from consumer products with proper
identification, namely high-density polyethylene (HDPE), polyethylene terephthalate (PET),
expanded polystyrene (EPS), cellulose acetate (CA), polyvinyl chloride (PVC) and nylon. Weathered
polymers were collected in Barra beach, Aveiro, Portugal and identified by Fourier Transform
Infrared Spectroscopy (FTIR) as HDPE, polyethylene (PE), polyethylene fibers (PEf), PP, EPS and CA.
Based on the demand for fibers (Textile World 2015), the following textile fibers were store
bought or obtained from consumer products: cotton (100%), linen (100%), polyester (100%),
cotton and polyester (50% - 50%), polyamide (100%), viscose (100%), nylon (unknown), rayon
(unknown). Although nylon is considered a polyamide, nylon (from a stocking) was subsequently

considered separately from polyamide (fabric).

Organic materials were collected in Costa Nova beach, Aveiro, Portugal (Fucus genus algae,
driftwood, feathers, bivalve shell, charcoal) or store bought (fish muscle, shrimp chitin shell,
shrimp muscle, palm fat, paraffin). Filters of quartz (2.2 um, Whatman QMA, U.S.A.), glass
microfiber (1.2 um, Prat DUMAS, France), nitrocellulose (0.2 um, GVS filter technology, U.K.),
mixed cellulose esters (0.45 um, Gridded GN-6 White, GelmanSciences, U.S.A.), black

polycarbonate filters (PCTE, 0.2 um, GE Healthcare Whatman, U.S.A.), C18 Octadecyl (12 um, 3M™
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Empore™, U.S.A.) were also subjected to staining to evaluate their possible interference in future

results.

2.3. Staining dye solutions testing

Following and adaptation of Ziajahromi et al. (2017) and Maes et al. (2017a), plastics, textile fibers
and natural organic matter were kept in glass flasks and subjected to 0.5 mL of staining dye
solution (enough to cover the sample), left to react for 30 minutes in the dark, washed with
distilled water in a mesh, and dried at 752C for 1 hour (Avangard.Line, BINDER, Germany), except
materials prone to melting, such as fat or paraffin, which dried over the counter overnight.
Afterwards, the samples were photographed (Canon IXUS 240HS) under visible light and two
wavelengths of UV-light (254 and 365 nm, VL-6.LC Vilber, Germany) to evaluate fluorescence.
Infrared spectrum of stained or fluorescent materials were obtained by Fourier transform infrared
spectroscopy attenuated total reflectance (FTIR-ATR) in a Perkin Elmer (U.S.A.) Spectrum BX FTIR

instrument at a resolution of 4 cm™, range of 4,000-600 nm and 32 scans.

2.4. Wavelengths testing

Nile Red was identified as the most efficient in coloring different types of polymers and synthetic
textiles under the first test conditions. In the literature, excitation wavelengths used for Nile Red
stained microplastics vary from 365 to 510 nm (Erni-Cassola et al. 2017; Maes et al. 2017a; Mason
et al. 2017; Shim et al. 2016; Tamminga et al. 2017), leading to differences in stained particles
emission and thus on microplastic quantification. To identify the optimal wavelength for the

excitation of Nile Red stained synthetic polymers, we tested under the same conditions the first
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two wavelengths (254, 365 nm) and five more (395, 470, 495, 530, 625 nm) using forensic light
sources and filters FOCUS LED (SPEX Forensic, U.S.A.) on synthetic polymers, synthetic textiles,
natural organic matter and filters. Filters were orange for 470 and 495 nm (Standard ProMaster®

Orange Filter)., and red for 530 and 630 nm (Standard ProMaster® Red Filter).

2.5. Development and evaluation of the image analysis software (MP-VAT, MP-ACT, MP-SCALE)

Microplastic Visual Analysis Tool (MP-VAT) was developed in the freely available Image )

(https://imagej.nih.gov/), leveraging thresholding and analysis tools. Since users need to set a

scale for each picture, and most pictures will be filters with known diameters, a macros was also
developed to set a scale based on the diameter of a selection, MP-SCALE. Thus, filters with known
diameters can be used as scale by adjusting a circular selection over it (with “make ellipsoid” tool)
and running the aforementioned macros. Furthermore, a macros was developed that produces
similar results to MP-VAT, but allows the user to manually set the threshold, the Microplastics

Automated Counting Tool (MP-ACT). All scripts can be found in the Supporting Information (S.1.).

To understand the efficiency of microplastic detection by MP-VAT we have conducted a series of
evaluation procedures using: (a) images created on Adobe Photoshop CS6; (b) images created
digitally through a program developed in R named Microplastics R generated (MP-Rgen); (c)
photographs of spiked filters. In Adobe Photoshop CS6, a fluorescence particle was copied and
pasted in order to generate images ranging from 5 to 150 particles in intervals of 5. This rounded
particle was originally copied from a photograph of a polyethylene spiked sample in a glass fiber
filter stained with Nile Red (Canon 550D, EF-S 18-55 mm, F-stop F5.6, ISO 1600, exposure time
1/13 seg). The background of the images was generated by tiling and blurring (10) a background

area of the same photograph in order to mimic some of the noise. In R, a program was created
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(MP-Rgen) in order to generate images with a known number of particles varying in size and
intensity. Ten images were generated by this method with particle numbers determined by the
random function in Excel, ranging from 1 to 50. Finally, a suspension of unknown concentrations of
very small shredded polyethylene (Sigma-Aldrich, U.S.A.) was prepared in ultrapure water and
filtered in varying volumes in glass fiber filters (in order to generate random numbers of particles),
stained with Nile Red, dried at 752C for 1 hour, and photographed (Canon 550D, EF-S 18-55 mm, F-
stop F5.6, ISO 1600, exposure time 1/13 seg). All images and photographs were quantified using
MP-VAT. Photographs of spiked filters were also quantified by two operators in order to compare
to MP-VAT results. Moreover, to test the general applicability of the method, 6L of tap water were
filtered in glass fiber filters and photographed using a different camera (Panasonic LUMIX FZ150)
by a different operator (Figure S-7, S.l.). Moreover, a 10 mL solution of 0.01 mg ml* of
polyethylene nanospheres (0.74 — 4.99 um, 0.98 g cc’, Cospheric, U.S.A.) prepared in ultrapure
water were filtrated in a glass fiber filter and photographed under fluorescent microscopy (GFP

green fluorescent protein, Fluorescence Microscope Zeiss, Axio Imager 2 Zeiss, Germany).

Finally, MP-VAT was used in the quantification of fluorescent particles in real environmental
samples, namely water and sediment from a river in Aveiro, Portugal. Water was collected in glass
bottles (previously washed in acid, distilled water, and river water) capped with aluminum foil, and
500 ml filtered in glass fiber filters (GFFA, PratDUMA, France). In the case of sediments, these
were collected in a glass flask (previously washed in acid and distilled water), 200 ml of a solution
of 30% NaCl were added to 25 g of sediment (d.w) in a glass beaker, manually stirred with a glass
rod for 2 minutes, let to settle for 1 hour, and the supernatant filtered in glass fiber filters (GFFA,
PratDUMA, France)(adapted from Maes et al. 2017b). After drying, both filters were subjected to
organic matter removal through the application of a solution of 10 mL of 15% hydrogen peroxide

(H,0,) and 10 mL of 0.05 M of iron catalyst (Fe), left to react at 509C for 1h (Prata et al. 2019b),
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washed with distilled water, dried, stained with Nile Red (0.01 mg ml™?), washed with distilled
water, dried overnight at room temperature followed by 752C for 1 hour, and photographed under
470 nm using the orange filter (Canon 550D, EF-S 18-55 mm, F-stop F5.6, ISO 1600, exposure time

1/13 seg).

3. Results & Discussion

3.1. Staining dye solutions evaluation

3.1.1. Virgin and weathered polymers

Virgin and weathered polymers were subjected to 8 staining dye solution (0.01 mg ml™) exposed
to two wavelengths, 254 and 365 nm. Most polymers did not present significant coloration under
visible light, except for both virgin and weathered CA. Thus, under 0.01 mg ml™, the staining dye

solutions may not be suitable to aid visual identification without the use of a specific wavelength.

From the 8 staining dye solutions, Nile Red presented the best results as it made most synthetic
polymers fluorescent (Table S-1 and S-2, S.I.). Under 254 nm, LDPE, PET, PP, EPS and CA had
strong fluorescence, whereas HDPE, PS and PVC presented dim fluorescence (probably due to
their crystalline surface) and nylon presented no fluorescence. Worst results were obtained under
365 nm, where only LDPE, PP, EPS and CA presented fluorescence, but with lower intensities.
Spectrum of synthetic polymers did not suffer any significant change after staining with Nile Red

(Figure S-1, S.1.).

Other staining dye solutions did not present a good affinity for a large range of polymers.

However, some of these staining dye solutions may be useful for specific tests. For instance, under
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254 nm, PET presented fluorescence with Acridine Orange (green) and virgin CA for Neutral Red

(yellow), Basic Blue 24 (purple), Acridine Orange (green) and Safranin-T (yellow).

Weathering, through changes in surface chemistry (Da Costa et al. 2018), may lead to changes in
the fluorescence of stained plastics. Fluorescence was observed in weathered HDPE, PP, EPS and
CA stained with Nile Red at 254 nm. However, weathered PE (both fragment and fiber) did not
present fluorescence under these conditions, even though virgin LDPE and HDPE did. Thus,
protocols using Nile Red under 254 nm light should be carefully implemented due to the potential

underestimation of PS, PVC, nylon and weathered PE in their samples.

Maes et al. (2017a) have proposed that the solvatochromic nature of Nile Red could lead to
different coloration of different types of polymers due to surface polarity. Thus, polar polymers
(e.g. nylon, PET) would present fluorescence in the red, whereas hydrophobic polymers (e.g. PE,
PP, PS) would present fluorescence in the yellow. This hypothesis is consistent with our results,
except for PS which presented orange fluorescence, and nylon, which was not fluorescent.
However, it is not possible to attest for this application in the case of weathered polymers, where
changes in polarity happen due to surface degradation, as only representatives of hydrophobic
polymers were tested. Thus, confirmation of this premise requires further research, which fell out

of the scope of the described work.

3.1.2. Textile fibers

Besides microplastics, synthetic fibers (i.e. microfibers) have a widespread use leading to their
presence in the environment (Dris et al. 2018). As with polymers, the 254 nm wavelength
produced the best results for textile fibers. Under this wavelength, for Nile Red stained textiles,
strong fluorescence was observed for linen, polyamide and rayon, whereas dim fluorescence was

10
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observed for viscose, nylon, and polyester (Table S-3, S.l.). Thus, nylon may present different
fluorescence than polyamide due to differences in their chemistry or surface (e.g. thick crystalline

fiber in nylon, e.g. Table S-3, S.1.).

The low fluorescence of polyester under these conditions is almost imperceptible when the textile
is a mixture of polyester and cotton. Cotton and wool presented no fluorescence due to staining.
Wool presented red fluorescence in all treatments, but this is attributed to its original red color.
White-bluish fluorescence was also observed in white textiles, but not attributed to staining with
Nile Red. Even though fluorescence after Nile Red staining was observed for pieces of textile fibers
and fluffs (Table S-6, S.l.), the same was not observed for individualized fibers, a shortcoming of

this protocol.

Other staining dye solution may also be interesting in detecting some of these textiles. This is the
case of Acridine Orange and Safranin-T for linen and viscose, and Neutral Red, Basic Blue 24,
Acridine Orange and Safranin-T for rayon. Spectra of textile fibers did not suffer any remarkable

change after staining with Nile Red (Figure S-2, S.1.).

3.1.3. Natural Organic matter

Ideally, staining protocols should be able to stain synthetic polymers and textile fibers without
staining natural organic matter in the sample. If organic matter is stained, an extra step of removal

may be required. Thus, organic matter commonly found in beach sediments was tested.

No fluorescence was found for any of the staining dye solutions under both wavelengths (254 and
365 nm) for algae, driftwood, paraffin, feather, shrimp shell (chitin), bivalve shell (calcium

carbonate), charcoal and palm fat (Table S-4, S.1.). Only shrimp muscle and fish muscle presented

11
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fluorescence when stained with Nile Red (both 254 and 365 nm) and with Safranin-T (365 nm).
However, muscle tissue is not likely to be abundant in microplastic samples since it is readily
consumed by organisms. Thus, staining dye solutions did not cause fluorescence in organic matter

under 254 and 365 nm light, except for muscle tissue.

3.1.4. Filters

Most microplastic sampling protocols involve a filtration step. Thus, it is expected that staining dye
solutions to be applied to filters containing microplastic samples. In order to correctly identify
microplastics, filters should not present fluorescence when stained. Thus, 6 types of filters were

subjected to the 8 staining dye solutions and two wavelengths.

Most filters presented visible coloration, but this was not always related to fluorescence under
UV-light. Nile Red presented fluorescence under 254 nm for all filters except for glass fiber and
PCTE (Table S-5, S.l.). Quartz, Nitrocellulose and Mixed Cellulose Ester filters also presented
fluorescence for Neutral Red, Acridine Orange and Safranin-T. Glass fibers presented fluorescence
for Acridine Orange and Safranin-T. Octadecyl filter was fluorescent in Neutral Red, Basic Blue,
Acridine Orange, Safranin-T. PCTE did not present fluorescence under any stain. Thus, glass fiber

and PCTE filters are recommended when using Nile Red staining dye protocols under 254 nm.

3.2. Testing Nile Red sampled under multiple wavelengths (254, 365, 470, 495, 530, 625 nm)

Nile Red was identified as the best of the 8 staining dye solutions tested under 254 and 365 nm.

Thus, virgin and weathered polymers, textiles, organic matter and filters stained with Nile Red
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were exposed to wavelengths of 254, 365, 470, 495, 530 and 625 nm (Table 1). The objective was

to find the best wavelength to identify synthetic polymers.

[Table 1]

As observed herein, the 254 nm once again produced good results, leading to strong fluorescence
of most polymer types except for PS, PVC, nylon, virgin HDPE and weathered PE. Polyester, nylon,
rayon, linen and polyamide were also fluorescent. At this wavelength, organic matter does not
present fluorescence from staining (except for shrimp and fish muscle) whereas most filters are
fluorescent, with the exception of glass fiber and PCTE. At 365 nm, similar results to 254 nm are
obtained but with a lower fluorescence intensity, complicating detection. At 395 nm, no

fluorescence from Nile Red was observed.

At 470 nm, almost all polymers and all textiles (except nylon) showed strong fluorescence. Only
virgin HDPE and PVC and weathered PE fibers do no present fluorescence. At this wavelength,
quartz filters become less fluorescent (only in the edges), besides glass fiber and PCTE. However,
this wavelength leads to fluorescence of stained natural organic matter as well, namely, driftwood,
feather, shrimp and fish muscle and shrimp shell (chitin). Thus, the use of the 470 nm wavelength
requires a previous step of organic matter removal to ensure that the fluorescent particles are

indeed synthetic.

The 495 nm is also acceptable, with slightly less fluorescence, including of filters, which may be an
advantage. However, the fluorescence green background (of the countertop) and the dimmer
fluorescence of polymers may complicate identification. It is worth noting that Nile Red stained
weathered PE is only fluorescent under 470 and 495 nm (Table S-7, S.1.). At 530 nm, only CA and
most textiles (except for viscose and wool) are fluorescence. At 625 nm, no synthetic polymer,

textile fiber, natural organic material or filter is fluorescent.
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Overall, the 254 and 470 nm were recognized as the best wavelengths to identify synthetic
materials. It is possible that commonly available lights in these wavelengths (and an orange filter
for 470 nm) are suitable for microplastic identification after Nile Red staining, allowing a cheap
identification method. The 470 nm has the advantage of revealing the fluorescence of PS, nylon,
weathered PE, and all the textiles (except nylon). The 254 nm has the advantage of a higher
contrast with the background (dark), no fluorescence of organic matter, but presents fluorescence
for only a limited number of synthetic materials. Furthermore, samples should always be dried
before being photographed, as wet samples generally presented lower fluorescent intensity when
compared to samples dried at 752C for 1 hour, a procedure that improves the identification of PVC

and PET under 470 nm (Figure S-9).

3.3. Developing image analysis software in Image)

3.3.1. Development and use of MP-VAT

Image J is a free software often used to analyze and automatically count particles, such as cells
(Forero et al. 2009; Grishagin 2015) and nanoparticles (Mahadevan et al. 2015; McQuaid et al.
2016). Thus, Image J could also be used to count fluorescent microplastics. Previous works have
used this software for manual counting of microplastics (Davidson 2012; Erni-Cassola et al. 2017;
Isobe et al. 2014; Isobe et al. 2017), but in none full automatization was attempted. Erni-Cassola et
al. (2017) stated to have written a macros for the detection of fluorescent microplastics, but there
was no evaluation and settings were situation specific, requiring subjective modification by each
user. Thus, the Microplastics Visual Analysis Tool (MP-VAT) was created to automatically count

fluorescent microplastics stained with Nile Red on Imagel.
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Using Imagel functionalities, an automatic threshold was established capable of identifying
fluorescent particles, removing subjective selection of this parameter (Figure 1). Furthermore,
using circularity (varying from 0, for elongated shapes, to 1, for perfect circle), categories such as
fiber (0.0-0.3), fragments (0.3-0.6), and particles (0.6-1.0) were roughly defined (Figure S-6, S.l.).
Beside circularity (Circ) and area, the program also produces an approximation of the largest and

smallest dimension of the particle, presented respectively as Feret and MinFeret.
[Figure 1]

MP-VAT will be available in the tool bar as a button (“MP VAT”) after installing
(Plugin>Macros>Install). Afterwards, the user must open an-image (File>Open) and set a scale
manually (Analyze>Set Scale) or using the filter's diameter using MP-SCALE. With the area to be
analyzed selected (using the first or second button on the toolbar), the user only needs to click on
the “MP-VAT” button and wait for the process to finish. The results are automatically saved in the

same folder as the analyzed image as a .xls files, that can be opened in Microsoft Excel.

Filters with two backgrounds colors (e.g. clear edges and dark sample circle) may require setting
the scale using the filter and then selecting only the inner circle to be analyzed by MP-VAT.
Photography settings for each user may require testing before using MP-VAT in samples. For
instance, excess brightness may lead to faulty detection of particles (Figure S-7, S.l.). Limit of
detection will vary with the resolution and photography conditions (particles detected vary from 4
to 1 million pixels). Thus, it is of utmost importance that users always mention the scale used in
their MP-VAT analysis (Analyze>SetScale; e.g. 51 px mm™), since it will influence the lower limit of
detection for size (e.g. considering particles >3 px in a scale of 51 px mm™ means MP-VAT will only

detect particles >0.05 mm). Large fragments may need to be removed from the sample through

15



334

335

336

337

338

339

340

341

342

343

344

345

346

347

348

349

350

351

352

353

354

355

356

sequential filtration as their strong fluorescence may compromise detection of smaller particles

and produce inconsistent results in MP-VAT due to the presence of a fluorescent halo.

MP-VAT has shortfalls regarding the lack of detection of color, polymer type and exact shape.
However, it overcomes some of the disadvantages of visual counting, such as objectivity, speed
and high throughput. Thus, MP-VAT constitutes a marked an improvement in the visual
qguantification of microplastics. More information on MP-VAT can be found at

http://mpvat.wordpress.com.

3.3.2. Evaluation of MP-VAT in the quantification of fluorescent particles

MP-VAT evaluation was accomplished through three different techniques: (a) Adobe Photoshop
CS4 reconstruction of images with known number of particles (Figure S-3, S.l.); (b) digital
generation of a known number of particles using an R program (Figure S-4, S.1.); (c) polyethylene
spiked filters photographs (Figure S-5, S.l.). These three methods were chosen due to their
increasing complexity in image composition. Furthermore, due to their microscopic size,
polyethylene spikes were conducted in random concentrations followed by quantification by two
operators. Thus, the first two methods were used to assess the precision of quantification in

images where a nominal concentration is known.

In the first technique, MP-VAT was able to correctly quantify images generated in Adobe
Photoshop CS4 with a number of particles from 5 to 150, in intervals of 5, with an average
recovery rate of 100% (+0; Table S-8, S.l.). However, these particles offered little complexity. In
the second procedure, ten images containing a known number of blobs, between 0 and 50
(number randomly generated by Excel), were generated in R in MP-Rgen and processed in MP-
VAT, with a recovery range of 97.4 — 109.8%, with an average of 104.6% (Table 2). In this case,
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overlapping particles were counted as a single particle, a limitation of MP-VAT that could also
occur in visual counting, or the digital separation of particles by watershedding created artificial

pieces from a single particle

[Table 2]

Five spiked PE samples were photographed under 470 nm (with orange filter) to calculate the
recovery of MP-VAT. As indicated in Table 2, the recovery rate for the quantification of fluorescent
particles is in the range of 96.9 — 105.3% between two different operators and of 89.0 — 111.1%
for MP-VAT (compared to the average count of the operators), with the average recovery for all
samples of 101.0% and 100.9% respectively, suggesting accuracy of both methods. In the
photographs analyzed, under our set conditions, the lowest size for the maximum particle
diameter (Feret) found was 65 pum for full filter photographs (~47 px mm™) and 0.65 pm for
fluorescence microscopy (~4.38 px um™). The size of 0.65 pm found for PE nanospheres where
slightly smaller than that reported by the manufacturer (0.74 um), possibly due to small errors

setting the scale or the presence of smaller particles.

The application of MP-VAT to real environmental samples, namely river sediment and water,
indicates its use even for complex matrices (Figure 2). In real environmental samples, chemical
digestion may be required to remove organic matter, fluorescent under 470 nm when stained with
Nile Red. The digestion protocol used (Prata et al. 2019b) wrinkled the filter, which did not
compromise the use of MP-VAT. Nonetheless, a digestion protocol must be developed in order to
preserve the filter structure while removing organic matter that may have fluorescent under 470

nm, and its success evaluated through micro-spectroscopy techniques.

3.3.3. Using MP-ACT in samples contaminated with fibers or natural organic matter
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Imagel can also be leveraged in cases of more conservative analysis using the 254 nm wavelength.
However, working in a clean room under a laminar-flow hood did not prevent filter contamination
with settling fibers, which have natural blue fluorescence under 254 nm, potentially leading to MP-
VAT estimation errors. The likely source of this contamination is the white cotton lab coat worn by
operators in this room. This could be justified by the use of fluorescent brightening agents in
textiles, which present fluorescence under UV light (Christie 1994). Thus, these fibers were not
fluorescent under 470 nm, in which no contamination was apparent and unlikely to happen after

the staining procedure.

As an alternative, we have quantified Nile Red fluorescent particles under 254 nm by selecting only
red particles using a color threshold. This was achieved by generating an image comprised only of
particles with a hue of 217 to 255, corresponding to violet to red (Saturation: 0-255; Brightness: O-
255), and threshold color B&W (Image>Adjust>ColorThreshold), and counting them using MP-ACT,
which generated the same output table as MP-VAT but allows user threshold setting (S-8, S.I.).
Even though the use of MP-VAT is preferred, this method might offer an alternative to samples
rich in fiber cross-contamination or in non-removable natural organic matter. However, as
previously stated, not all microplastics are fluorescent under 254 nm (e.g. weathered PE) possibly
leading to an underestimation of microplastics in the sample. Furthermore, this method cannot be

subjected to evaluation or validation, as users are required to set threshold parameters.

3.3.4. Next steps and future applications of MP-VAT

Even though MP-VAT presented satisfactory results, more tests should be performed in order to
fully validate this method. In the future, MP-VAT should be validated using spikes of different

polymer types, compared to several independent counts by operators or techniques. The use of
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MP-VAT on environmental samples should also be explored in more detail through coupling with
spectroscopic methods (e.g. micro-FTIR). Furthermore, the appropriate removal of organic matter
from samples prior to staining with Nile Red needs to be optimized in order for MP-VAT to
produce reliable results. This improvement, along with the optimization of sampling procedures,
could be used in harmony with MP-VAT, culminating into a single protocol of microplastic
identification that could be validated. Moreover, MP-VAT is not able to determine the chemical
composition of samples (i.e. polymer type) but allows simple and quick guantification and rough
characterization of size and shape of microplastic. Thus, it could be considered a complementary
procedure to spectroscopic methods. In the future, MP-VAT and spectroscopic methods (e.g.
micro-Raman) could be paired in order to produce a more complete characterization of
microplastic samples. This could be accomplished, for instance, by first running the spectroscopic
analysis, followed by staining and MP-VAT evaluation. Thus, MP-VAT presents a promising

complement for the routine quantification and characterization of microplastics.

4. Conclusion

A new approach for routine quantification of microplastics was developed using Nile Red coupled
with an automated counting software, MP-VAT. In a first test, eight staining dye solutions were
compared, leading to the selection of Nile Red as the most appropriate for the staining of
synthetic materials. A second test allowed the determination of the best excitation wavelengths
for synthetic materials stained with Nile Red, namely 254 and 470 nm. Finally, an automated
counting software (MP-VAT) was developed in Imagel and evaluated, presenting promising results
for its application on microplastic samples. In the future, MP-VAT could be further tested and

improved by validation and comparison with reference techniques (e.g. spectroscopic methods).
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Supporting Information
Supporting Information contains additional information about Fourier Transform Infrared
Spectroscopy (FTIR), photographs of stained materials, images used in the evaluation of MP-VAT

and all the scripts for the programs developed.
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Table 2. Recovery of fluorescent particles by MP-VAT compared to average operator count (in

spiked filters) and nominal number (in MP-Rgen).

Sampl Count Recovery (%) Pearson Correlation
e
Spiked | Operator MP Operator MP- 100
filters s - s VAT 90 o 5
VA — 80
T <>|( 70
o 60
39 45 105.3 111. > o
o0 y=0.8261x +9.7961
1 40 R? = 0.9665
40.5 43 97.6 110. 30
3 30 40 50 60 70 8 90 10C
48 45 104.3 93.8 Operators
95.5 85 96.9 89.0
84.5 85 101.2 100.
6
Mean (£S.D.) 101.0 100.
(+3.8) 9
(£9.8
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41 45 109.8 .
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48 53 110.4
Mean (£S.D.) 104.6 (+4.6)
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Tables & Figures

Table 1. Fluorescence of virgin polymers, weathered polymers, textiles, natural organic matter, filters unstained and stained with Nile Red under
different wavelengths.

A Virgin Polymers Weathered Polymers Textiles Natural Organic Matter Filters

(nm) Unstained Nile Red Unstained Nile Red Unstained Nile Red Unstained Nile Red Unstained Nile Red
vis T +<s AT ol RS RBive/e LN
495 ELLU m
530 BEEECE T
625 TR (W T | 5

Virgin Polymers (left to right): low-density polyethylene (LDPE), high-density polyethylene (HDPE), polyethylene terephthalate (PET), polypropylene (PP), polyvinyl chloride (PVC), polystyrene (PS),
expanded polystyrene (EPS), cellulose acetate (CA), nylon. Weathered Polymers (left to right): PE, HDPE, PP, PE fibers, EPS, CA; PE-W: polyethylene. Textiles (left to right): cotton, cotton+polyester,
polyesters, viscose, nylon, wool, rayon, linen, polyamide. Natural Organic Matter (left to right): algae, driftwood, feathers, shrimp shell (chitin), shrimp muscle, fish muscle, shell (carbonate), carbon.
Filters (left to right): C18 octadecyl, black polycarbonate (PCTE), glass fiber, mixed cellulose esters, quartz, nitrocellulose.
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Figure 1. Glass fiber filter spiked with PE, stained with Nile Red and photographed under 470 nm
(particles=53; 59.99 px mm™’; A, B); glass fiber filters spiked with PE nanospheres and
photographed under fluorescent microscopy (particles=40; 4.40 px um™; C, D).

Figure 2. Sample of 500 mL of river water filtered in a glass fiber filter (A), subjected to organic
matter removal, and photographed under 470 nm (particles=7; 49.42 px mm™; B, C); supernatant
of 25 g of river sediment separated by 30% NaCl and filtered in a glass fiber filter (D), subjected to
organic matter removal, and photographed under 470 nm (particles=32; 47.38 px mm™; E, F).
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Highlights

e Nile Red was the best of eight dyes for staining microplastics

e Wavelengths of 254 and 470 nm produce the best results for Nile Red

e MP-VAT was developed for automatic quantification of fluorescent microplastics

e MP-VAT quantifies and characterizes microplastics based on shape and size

e Recovery rates of 87.6-106.3% deem MP-VAT accurate for microplastic quantification
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